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Module I : Fundamentals of Computer  

Basic concepts and components of a computer – CPU, input – output devices –bit, byte, data storage, retrieval, 
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Disk Operating System, Windows & LINUX [Basic ideas only] – operating systems.  
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Introduction : overview, basic terminology – tool bars, scrolling, word processing, formatting text and document 
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Working with date – managing Excel workbooks 7& worksheets – formulas and functions – formatting data – 
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Internet basics – search engines – opening e-mail id – downloading text from internet – uses of internet for 

business and commercial activities.  
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MODULE I : FUNDAMENTALS OF COMPUTER  

What is a Computer? 

A computer is an electronic device that accepts data from the user, processes it, produces results, displays them 

to the users, and stores the results for future usage. 

Data is a collection of unorganized facts & figures and does not provide any further information regarding 

patterns, context, etc. Hence data means "unstructured facts and figures". 

Information is a structured data i.e. organized meaningful and processed data. To process the data and convert 

into information, a computer is used. 

Functions of Computers 

A computer performs the following functions − 

Receiving Input 

Data is fed into computer through various input devices like keyboard, mouse, digital pens, etc. Input can also be 

fed through devices like CD-ROM, pen drive, scanner, etc. 

Processing the information 

Operations on the input data are carried out based on the instructions provided in the programs. 

Storing the information 

After processing, the information gets stored in the primary or secondary storage area. 

Producing output 

The processed information and other details are communicated to the outside world through output devices like 

monitor, printer, etc. 

History of Computers 

The history of the computer dates back to several years. There are five prominent generations of computers. 

Each generation has witnessed several technological advances which change the functionality of the computers. 

This results in more compact, powerful, robust systems which are less expensive. The brief history of computers 

is discussed below − 

First Generation (1940-1956) 

The first generation computers had the following features and components − 

Hardware 

The hardware used in the first generation of computers was: Vacuum Tubes and Punch Cards. 

Features 

Following are the features of first generation computers − 

• It supported machine language. 

• It had slow performance 

• It occupied large size due to the use of vacuum tubes. 



• It had a poor storage capacity. 

• It consumed a lot of electricity and generated a lot of heat. 

Memory 

The memory was of 4000 bits. 

Data Input 

The input was only provided through hard-wired programs in the computer, mostly through punched cards and 

paper tapes. 

Examples 

The examples of first generation computers are − 

• ENIAC 

• UNIVACTBM 701 

Second Generation (1956-1963) 

Several advancements in the first-gen computers led to the development of second generation computers. 

Following are various changes in features and components of second generation computers − 

Hardware 

The hardware used in the second generation of computers were − 

• Transistors 

• Magnetic Tapes 

Features 

It had features like − 

• Batch operating system 

• Faster and smaller in size 

• Reliable and energy efficient than the previous generation 

• Less costly than the previous generation 

Memory 

The capacity of the memory was 32,000 bits. 

Data Input 

The input was provided through punched cards. 

Examples 

The examples of second generation computers are − 

• Honeywell 400 

• CDC 1604 



• IBM 7030 

Third Generation (1964-1971) 

Following are the various components and features of the third generation computers − 

Hardware 

The hardware used in the third generation of computers were − 

• Integrated Circuits made from semi-conductor materials 

• Large capacity disks and magnetic tapes 

Features 

The features of the third generation computers are − 

• Supports time-sharing OS 

• Faster, smaller, more reliable and cheaper than the previous generations 

• Easy to access 

Memory 

The capacity of the memory was 128,000 bits. 

Data Input 

The input was provided through keyboards and monitors. 

Examples 

The examples of third generation computers are − 

• IBM 360/370 

• CDC 6600 

• PDP 8/11 

Fourth Generation (1972-2010) 

Fourth generation computers have the following components and features − 

Hardware 

The Hardware used in the fourth generation of computers were − 

• ICs with Very Large Scale Integration (VLSI) technology 

• Semiconductor memory 

• Magnetic tapes and Floppy 

Features 

It supports features like − 

• Multiprocessing & distributed OS 



• Object-oriented high level programs supported 

• Small & easy to use; hand-held computers have evolved 

• No external cooling required & affordable 

• This generation saw the development of networks and the internet 

• It saw the development of new trends in GUIs and mouse 

Memory 

The capacity of the memory was 100 million bits. 

Data Input 

The input was provided through improved hand held devices, keyboard and mouse. 

Examples 

The examples of fourth generation computers are − 

• Apple II 

• VAX 9000 

• CRAY 1 (super computers) 

Fifth Generation (2010-Present) 

These are the modern and advanced computers. Significant changes in the components and operations have 

made fifth generation computers handy and more reliable than the previous generations. 

Hardware 

The Hardware used in the fifth generation of computers are − 

• Integrated Circuits with VLSI and Nano technology 

• Large capacity hard disk with RAID support 

• Powerful servers, Internet, Cluster computing 

Features 

It supports features like − 

• Powerful, cheap, reliable and easy to use. 

• Portable and faster due to use of parallel processors and Super Large Scale Integrated Circuits. 

• Rapid software development is possible. 

Memory 

The capacity of the memory is unlimited. 

Data Input 

The input is provided through CDROM, Optical Disk and other touch and voice sensitive input devices. 

Examples 



The examples of fifth generation computers are − 

• IBM 

• Pentium 

• PARAM 

 

Characteristics of Computer System 

The characteristics of the computer system are as follows − 

 

Speed 

A computer works with much higher speed and accuracy compared to humans while performing mathematical 

calculations. Computers can process millions (1,000,000) of instructions per second. The time taken by 

computers for their operations is microseconds and nanoseconds. 

Accuracy 

Computers perform calculations with 100% accuracy. Errors may occur due to data inconsistency or inaccuracy. 

Diligence 

A computer can perform millions of tasks or calculations with the same consistency and accuracy. It doesn’t feel 

any fatigue or lack of concentration. Its memory also makes it superior to that of human beings. 

Versatility 

Versatility refers to the capability of a computer to perform different kinds of works with same accuracy and 

efficiency. 

Reliability 

A computer is reliable as it gives consistent result for similar set of data i.e., if we give same set of input any 

number of times, we will get the same result. 

Automation 

Computer performs all the tasks automatically i.e. it performs tasks without manual intervention. 



Memory 

A computer has built-in memory called primary memory where it stores data. Secondary storage are removable 

devices such as CDs, pen drives, etc., which are also used to store data. 

Components of Computer System 

Computer systems consist of three components as shown in below image: Central Processing Unit, Input 

devices and Output devices. Input devices provide data input to processor, which processes data and generates 

useful information that’s displayed to the user through output devices. This is stored in computer’s memory. 

 

Central Processing Unit 

The Central Processing Unit (CPU) is called "the brain of computer" as it controls operation of all parts of 

computer. It consists of two components: Arithmetic Logic Unit (ALU), and Control Unit. 

 

 



Arithmetic Logic Unit (ALU) 

Data entered into computer is sent to RAM, from where it is then sent to ALU, where rest of data processing 

takes place. All types of processing, such as comparisons, decision-making and processing of non-numeric 

information takes place here and once again data is moved to RAM. 

Control Unit 

As name indicates, this part of CPU extracts instructions, performs execution, maintains and directs operations 

of entire system. 

Functions of Control Unit 

Control unit performs following functions − 

• It controls all activities of computer 

• Supervises flow of data within CPU 

• Directs flow of data within CPU 

• Transfers data to Arithmetic and Logic Unit 

• Transfers results to memory 

• Fetches results from memory to output devices 

Memory Unit 

This is unit in which data and instructions given to computer as well as results given by computer are stored. 

Unit of memory is "Byte". 

Input Devices – Keyboard and Mouse 

Input devices help to get input or data from user. Some of input devices are − 

Name Characteristics 

Keyboard The keyboard was first peripheral device to be used with computers. 

It helps to input text and numbers into computer. 

It consists of 104 keys and 12 functional keys. 

Mouse A mouse is an input device which is also called as pointing device because it helps to point 

data on screen. 

It also helps to select, highlight content and drag-drop controls. 

 

 



 

Other Input Devices 

There are few other input devices which help to feed data to the computer. They are as follows − 

Input Devices Characteristics 

Trackballs A trackball is also a pointing device which will work like a mouse. It is mainly used for 

gaming and entertainment purpose. 

Digital Pens A digital pen is another input device which is mostly used with tablets, PDAs, etc. 

A digital pen is also called as a Stylus which helps to write or draw data over pad. 

Scanners Scanners transform printed material and photographs into a digital representation. 

After scanning of printed material, page is represented in memory as an array of pixels. 

Barcode 

Readers 

Barcode reader helps to read information which is printed as bars in back of goods or 

items. 

Barcode readers are most widely used input devices which we can see in most of products 

in our day to day life. 

Voice 

Recognition 

System 

Voice recognition system interprets or receives dictation or spoken commands to 

authorize user. 

Touch screen A touch screen is an input device which uses sensors to sense touch of users to get input 

data. 

 

Output Devices 

Output devices help to display output to user. Some of output devices are − 

Output Devices Characteristics 

Monitor A monitor is most common type of output device. 

It is also called as "Visual Display Unit". 

The inputs given by keyboard or any other input devices will get displayed on 

monitor. 

Cathode Ray Tube (CRT) and Flat panel display monitors are commonly used 

monitors. 



Printers Printers are most common type of output devices which are used to take a hard copy 

of any digital document. 

The two types of printers are impact and non-impact printers. 

Non-impact printers such as laser and inkjet printers are less noisy, more reliable and 

faster and also offer high quality compared to impact printers. 

Sound Systems Sound systems are output devices which are used to get multimedia content such as 

voice, music, etc., as output. Some of examples of sound systems are speakers, 

headphones, and microphones.  

 

Computer Memory 

Computer memory refers to storage area where data is stored. It is of two types − 

• Primary Memory 

• Secondary Memory 

Primary Memory 

Primary memory is the main memory of computer present in motherboard. Primary memory is of two types as 

shown in the image below. 

 

Random Access Memory 

RAM is referred as temporary memory, in which, information stored is lost once computer is turned off. It is a 

volatile memory. Instructions written in this memory can be modified; hence it is also known as programmable 

memory. The two types of RAM are Static RAM (faster and costlier) and Dynamic RAM. 

 

Functions of RAM are as follows − 

• It stores data till it gets processed. 

• It stores instructions for data processing. 

• It acts as a working space where data processing takes place and intermediate results are stored. 

• It stores processed data/results before it is sent to output devices. 



Read Only Memory 

ROM is referred as permanent memory, in which information stored is available even if computer is turned off. 

Instructions stored in this memory can only be read and cannot be modified. Mostly ROM has a start-up 

instruction which is executed every time when computer is switched on. Types of ROM are PROM 

(Programmable Read Only Memory), EPROM (Erasable PROM), EEPROM (Electrically Erasable PROM) and 

flash memory. 

 

The below table jots down the major differences between RAM and ROM − 

Sr.No RAM ROM 

1 It is volatile memory. It is non-volatile memory. 

2 The contents are temporary; data is lost 

when electricity supply is lost. 

The contents are permanent; data is not lost even 

when power is switched off. 

3 Available in small storage capacity. Available in high storage capacity. 

4 Processing speed is high. Processing speed is low. 

5 User-defined programs can be stored. Generally, operating system supporting programs 

can be stored. 

6 Cost is very high. Cost effective. 

7 It is of two types, SRAM and DRAM. It comes in different types such as PROM, 

EPROM, EEPROM and flash memory. 

Secondary Memory 

Sometimes when data to be processed is large, it cannot fit in primary memory as it is limited, in such cases, we 

use supplement memory or secondary memory. Secondary memory helps to store information permanently and 

is non-volatile. Examples of secondary storage memory are compact disk, floppy disk, pen drive, external hard 

drive, etc. 

Concept of Hardware and Software 

The concept of hardware and software is explained in detail below − 

Hardware 

The term hardware refers to mechanical device that makes up computer. Computer hardware consists of 

interconnected electronic devices that we can use to control computer’s operation, input and output. Examples of 

hardware are CPU, keyboard, mouse, hard disk, etc. 



 

Hardware Components 

Computer hardware is a collection of several components working together. Some parts are essential and others 

are added advantages. Computer hardware is made up of CPU and peripherals as shown in image below. 

 

Software 

A set of instructions that drives computer to do stipulated tasks is called a program. Software instructions are 

programmed in a computer language, translated into machine language, and executed by computer. Software can 

be categorized into two types − 

• System software 

• Application software 

System Software 

System software operates directly on hardware devices of computer. It provides a platform to run an application. 

It provides and supports user functionality. Examples of system software include operating systems such as 

Windows, Linux, Unix, etc. 

 

 

 



Application Software 

An application software is designed for benefit of users to perform one or more tasks. Examples of application 

software include Microsoft Word, Excel, PowerPoint, Oracle, etc. 

 

Differences between Software and Hardware are sorted out below − 

Sr.No. Software Hardware 

1 It is a collection of programs to bring computer 

hardware system into operation. 

It includes physical components of computer 

system. 

2 It includes numbers, alphabets, alphanumeric 

symbols, identifiers, keywords, etc. 

It consists of electronic components like ICs, 

diodes, registers, crystals, boards, insulators, etc. 

3 Software products evolve by adding new 

features to existing programs to support 

hardware. 

Hardware design is based on architectural decisions 

to make it work over a range of environmental 

conditions and time. 

4 It will vary as per computer and its built-in 

functions and programming language. 

It is mostly constructed for all types of computer 

systems. 

5 It is designed and developed by experienced 

programmers in high-level language. 

The hardware can understand only low-level 

language or machine language. 

6 

It is represented in any high-level language 

such as BASIC, COBOL, C, C++, JAVA, etc. 

The hardware works only on binary codes 1’s and 

0’s.  

7 The software is categorized as operating 

system, utilities, language processor, 

application software, etc. 

The hardware consists of input devices, output 

devices, memory, etc. 

 

 

 

 



MODULE II: OPERATING SYSTEM  

Operating System 

 An operating system is the fundamental basis of all other application programs. Operating system is an 

intermediary between the users and the hardware. 

Operating system controls and coordinates the use of hardware among application programs. The major services 

of an operating system are − 

• Memory management 

• Disk access 

• Creating user interface 

• Managing the different programs operating parallel 

• Likewise, it controls and manage the hardware’s working 

Definition 

An operating system is a program that acts as an interface between the user and the computer hardware 

and controls the execution of all kinds of programs. 

 

Memory Management 

Memory management refers to management of Primary Memory or Main Memory. Main memory is a large 

array of words or bytes where each word or byte has its own address. 

Main memory provides a fast storage that can be accessed directly by the CPU. For a program to be executed, it 

must in the main memory. An Operating System does the following activities for memory management − 

• Keeps tracks of primary memory, i.e., what part of it are in use by whom, what part are not in use. 

• In multiprogramming, the OS decides which process will get memory when and how much. 

• Allocates the memory when a process requests it to do so. 



• De-allocates the memory when a process no longer needs it or has been terminated. 

Processor Management 

In multiprogramming environment, the OS decides which process gets the processor when and for how much 

time. This function is called process scheduling. An Operating System does the following activities for 

processor management − 

• Keeps tracks of processor and status of process. The program responsible for this task is known as traffic 

controller. 

• Allocates the processor (CPU) to a process. 

• De-allocates processor when a process is no longer required. 

Device Management 

An Operating System manages device communication via their respective drivers. It does the following activities 

for device management − 

• Keeps tracks of all devices. Program responsible for this task is known as the I/O controller. 

• Decides which process gets the device when and for how much time. 

• Allocates the device in the efficient way. 

• De-allocates device 

File Management 

A file system is normally organized into directories for easy navigation and usage. These directories may contain 

files and other directions. 

An Operating System does the following activities for file management − 

• Keeps track of information, location, uses, status etc. The collective facilities are often known as file 

system. 

• Decides who gets the resources. 

• Allocates the resources. 

• De-allocates the resources. 

Other Important Activities 

Following are some of the important activities that an Operating System performs − 

• Security − By means of password and similar other techniques, it prevents unauthorized access to 

programs and data. 

• Control over system performance − Recording delays between request for a service and response from 

the system. 

• Job accounting − Keeping track of time and resources used by various jobs and users. 

• Error detecting aids − Production of dumps, traces, error messages, and other debugging and error 

detecting aids. 

• Coordination between other softwares and users − Coordination and assignment of compilers, 

interpreters, assemblers and other software to the various users of the computer systems. 



Applications of Operating System 

Following are the major applications of an operating system − 

• An operating system is accountable for the formation and deletion of files and directories. 

• An operating system manages the process of deletion, suspension, resumption, and synchronization. 

• An operating system manages memory space by allocation and de-allocation. 

• An operating system stores, organizes, and names and protects the existing files. 

• Further, an operating system manages all the components and devices of the computers system including 

modems, printers, plotters, etc. 

• In case, if any device fails, the operating system detects and notify. 

• An operating system protects from destruction as well as from unauthorized use. 

• An operating system facilitates the interface to user and hardware. 

Types of Operating System 

Following are the major types of operating system − 

• Disk Operating System (DOS) 

• Windows Operating System 

• Unix Operating System 

Let us now discuss each operating system in detail. 

Disk Operating System 

MS-DOS is one of the oldest and widely used operating system. DOS is a set of computer programs, the major 

functions of which are file management, allocation of system resources, providing essential features to control 

hardware devices. 

DOS commands can be typed in either upper case or lower case. 

Features of DOS 

Following are the significant features of DOS − 

• It is a single user system. 

• It controls program. 

• It is machine independence. 

• It manages (computer) files. 

• It manages input and output system. 

• It manages (computer) memory. 

• It provides command processing facilities. 

• It operates with Assembler. 

Types of DOS Commands 

Following are the major types of DOS Command − 



• Internal Commands − Commands such as DEL, COPY, TYPE, etc. are the internal commands that 

remain stored in computer memory. 

• External Commands − Commands like FORMAT, DISKCOPY, etc. are the external commands and 

remain stored on the disk. 

Windows Operating System 

The operating system window is the extension of the disk operating system. 

It is the most popular and simplest operating system; it can be used by any person who can read and understand 

basic English, as it does not require any special training. 

However, the Windows Operating System requires DOS to run the various application programs initially. 

Because of this reason, DOS should be installed into the memory and then window can be executed. 

Elements of Windows OS 

Following are the significant element of Windows Operating System (WOS) − 

• Graphical User Interface 

• Icons (pictures, documents, application, program icons, etc.) 

• Taskbar 

• Start button 

• Windows explorer 

• Mouse button 

• Hardware compatibility 

• Software compatibility 

• Help, etc. 

Versions of Windows Operating System 

Following are the different versions of Windows Operating System − 

Version Year Version Year 

Window 1.01 1985 Windows XP Professional x64 2005 

Windows NT 3.1 1993 Windows Vista 2007 

Windows 95 1995 Windows 7 2009 

Windows 98 1998 Windows 8 2012 

Windows 2000 2000 Windows 10 2015 

Windows ME 2000 Windows Server 2016 2016 

Windows XP 2001 
  

 



Unix Operating System 

The Unix Operating System is the earliest operating system developed in 1970s. Let us consider the following 

points relating to the Unix Operating System − 

• It is an operating system that has multitasking features. 

• It has multiuser computer operating systems. 

• It runs practically on every sort of hardware and provides stimulus to the open source movement. 

• It has comparative complex functionality and hence an untrained user cannot use it; only the one who has 

taken training can use this system. 

• Another drawback of this system is, it does not give notice or warn about the consequences of a user’s 

action (whether user’s action is right or wrong). 

 

MODULE III: MS WORD & MS POWER POINT  

Introduction 

 Microsoft word is an application software developed by Microsoft Inc. Microsoft is an American 

multinational technology company. It is word processing software. Microsoft Word is used to create, edit, print, 

and share professional-looking documents such as applications, forms, templates, business cards, letters, paper, 

reports, and booklets by using Microsoft Word. 

 You can buy the latest version of Microsoft 2016 for official works, in which all the powerful applications 

are included such as Microsoft Word, Excel, PowerPoint, Outlook, etc. in one complete package. 

Let’s take a look at functional bars in Microsoft Word 

Title Bar: – The title bar is on the top of the window when you open a Microsoft Word application. The title bar 

contains opened application name (Microsoft Word in this case), by default file name (document1) in the center, 

control buttons (close, maximize, minimize) in right side and quick access tools (word logo, save, undo-redo 

function) on the left side. 

Menu Bar: – Menu bar contains all the menus such as File, Home, and Insert, Page Layout, etc. These menus and 

functions are tools that are used to create all kinds of professional-looking documents in Microsoft Word. 

Standard Formatting Bar (Sub Menu): – These are the category of functions and features dived under Menus 

according to their use. Such as under Home Menu, you can find Clip Board, Font, Paragraph, etc. these are 

subcategories of Main Menu Bar. 

Ruler Bar: – Ruler bar is most important to understand. A rule bar is used to align the document. You can set 

margin and paragraph spaces by using it. You can find left indent, the right indent in the ruler bar. This is used to 

align the documents, page margins so when you print the document it will look professional.  There are two rule 

bars in Microsoft Word, one is on the top of the white page(typing area) and the second is on the left side. 

Scrolling Bar: – Scrollbar is used to scroll the page up/down and right/left when page zoom is high or low. There 

are two scrolling bars. One is the horizontal bar and the second one is the vertical scrolling bar. 

Status Bar: – The Status bar showcase page number, total words, selected words, etc. Its main work is the 

display the status of the page. You can find spelling and grammatical proofreading option in the right after page 

number and words. And on the right side of the status bar, there are page views, zooming options. 

Basic uses of Microsoft Word: – 



You can create, design, and edit letters, resume, bills, reports, applications, forms, birthday cards, business cards, 

calendars, books, articles, assignments in Microsoft Word and you can share them with your friends and also in 

public. And you can work with your team members in real-time on the same document. There are pre-designed 

templates that you can use to create various kinds of personal and official documents. 

There are three methods you can follow to use Microsoft Word. 

1. To create anything such as forms, resume, business cards, applications, and bills, etc. you need to visualize first, 

what kind of document you want to create. Such as if you want to create business cards in MS-Word then you 

need to visualize the colors, shapes, text, and alignment, etc. to give it a look you’re imagining. Basic knowledge 

of official documents is important to utilize the features of MS-Word. 

2. See the samples of existed documents on the Internet and then create similar by seeing the sample. Also, you can 

watch video tutorials on YouTube. So, you can learn the basics of this method. But more advanced knowledge of 

Microsoft features and function it’s better than you can join an online course if really want to learn quickly. 

3. You can also download a template related to your documents such as the current account opening application for 

a bank. After downloading the template then replace exists text with your own. Save the document by pressing 

Ctrl+S and Print the document or use Ctrl+P. 

It’s not that easy for the beginner or basic course student to learn Microsoft Word faster. But after 2-3 days of 

practical classes or by watching online videos related to Microsoft word Tutorial you can able to work on Word 

more frequently and with quality. 

WORD PROCESSING 

Word processing refers generally to the creation, editing, formatting, storage, and output of both printed and 

online or electronic documents. Word processing is undoubtedly the most-used business application for personal 

computers, perhaps alongside World Wide Web browsers and electronic-mail (e-mail) applications. 

 Word-processing software includes basic applications designed for casual business or home users and 

powerful, advanced applications capable of meeting the most-demanding needs of businesses. Many word-

processing applications are designed for use as part of a suite or integrated group of word-processing, 

spreadsheet, and presentation programs. For example, Microsoft Word, probably the most widely used word-

processing software, is part of the Microsoft Office suite, which includes Microsoft's PowerPoint presentation 

program and Excel spreadsheet program. Corel WordPerfect, a less widely used but very popular word-

processing program, is part of Corel's WordPerfect Office suite, which includes Quattro Pro spreadsheet software 

and Presentations multimedia slide-show software. 

 Some word-processing software is available as shareware for a relatively small fee or as freeware at no 

cost. For example, Yeah Write, a basic fill-in-the-blank word processor designed for people who do not want to 

deal with formatting tasks, is available as shareware. OpenOffice.org is a complete office suite that includes a 

powerful word-processing program, WRITER, which is intended as an open-standard, vendor-neutral alternative 

to proprietary word-processing programs. 

ESSENTIAL WORD-PROCESSING FUNCTIONS 

Essential word-processing functions can be grouped into the categories of input, manipulation, formatting, and 

output of text. 

Text Input 

Typically, text is entered into the word processor from a keyboard; other input methods include: 

https://www.encyclopedia.com/science-and-technology/computers-and-electrical-engineering/computers-and-computing/world-wide-web


• Copying text from other applications (such as from hypertext markup language [HTML] documents, e-mail 

messages, or online encyclopedias) and pasting it into a word-processing document 

• Scanning printed documents and using optical-character-recognition (OCR) software to convert the scanned 

documents into text characters 

• Using voice-recognition software to convert spoken words into text characters 

Text Manipulation 

Text manipulation refers to the "processing" part of word processing. Word processors provide easy methods of 

deleting, inserting, copying, and moving individual characters, words, phrases, and paragraphs—even entire 

pages of information—with a few clicks of a mouse button or with such keyboard shortcuts as Ctrl-C to copy, 

Ctrl-X to cut, and Ctrl-V to paste or insert text. Text can be automatically checked for spelling and for 

conformance to basic grammatical principles as the text is entered and edited. 

Text Formatting 

Word-processing software typically includes "wizards" or "help" features to provide automated formatting of 

common business documents. For example, a letter wizard can assist the user to properly format a business letter, 

and a résumé wizard can help the user format a professional-looking résumé. Templates are another automated 

formatting feature. A template is a type of pre-formatted, fill-in-the-blank document that is useful for maintaining 

a specific format each time a document is created, especially when multiple word-processing operators are 

involved. A newsletter template, for example, allows a user to entered the text of newsletter articles, headlines, 

and graphics without having to re-create the newsletter layout for each issue of the newsletter. 

Text Output 

Once text has been created, edited, and formatted into a finished electronic document, it must be put into some 

tangible form or lasting electronic form to be of practical benefit. That output process usually starts with the 

saving of the document on the computer's hard drive, a floppy disk, a CD, or a memory device such as a flash 

drive. Saving the document, in fact, is an activity that should take place frequently during the creation and editing 

processes to guard against loss due to problems such as electrical-power failure, computer malfunctions, and 

operator error. 

Formatting Text In Word 

Formatting text in Microsoft Word involves tasks like bolding the text, italicising it, and changing the font and 

size. The commands to perform all of these formatting tasks are found on the Home tab in the Font group. Select 

your text and then click on the required formatting button to see the effects. 

Alternatively, you can use the keyboard shortcuts for those commands. Here are the shortcuts for some of 

the more commonly used formatting commands: 

• Bold: ctrl-b 

• talic: ctrl-i 

• Underline: ctrl-u 

You can also set the formatting before you type by clicking the appropriate button or using the shortcut, and then 

anything you subsequently type will be formatted. To unset the formatting, you click the same command button or 

use the same shortcut. So you can see that these commands act like toggles. 

The Mini Toolbar In Word 
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You may notice that as soon as you select a block of text, a mini toolbar appears from nowhere. This toolbar 

displays the more popular formatting commands that you are most likely to use, to save you time. 

Tabs and sorting in MS Word  

 In a document, you might need to arrange a list of single line items, a group of multiple line paragraphs, or 

the rows of items in a table into alphabetical or numerical order. Word lets you sort lines and paragraphs of 

document text and rows of table information into logically defined sequences. 

Sorting Lists and Paragraphs 

By default, Word sorts the entire active document when you sort standard text. Text is separated into individual 

sort items at each hard return, and items are sorted by the letter(s) or word(s) that appear at the beginning of each. 

If you want to sort only a portion of the document, such as a list or a group of paragraphs, select the desired text 

before you begin the sorting process. Then, on the Home tab, in the Paragraph group, click Sort. Word opens the 

Sort Text dialog box, in which you define the desired sort options. 

 

Method 

 To sort lists and paragraphs: 

 If desired, select the text to be included in the sort. 

1. From the Home tab, in the Paragraph group, choose Sort. 

 

3. In the Sort Text dialog box, in the Sort by list box, make sure Paragraphs appears. 

4. In the Type list box, make sure Text appears. 

5. Select the desired order option button. 

6. In the My list has area, select the appropriate header option button. 

7. Choose OK. 



Sorting Tables 

You can sort rows of table information by any column in the table. You can perform a table sort by a single 

column in a table very quickly. Place the insertion point in the column you want to sort, then under Table Tools, 

on the Layout Tab, in the Data group, click Sort. In the Sort Dialog box select Sort Ascending or Sort Descending 

button, select if your list has a Header row or No Header row, and then click OK. 

To sort an entire table, move the pointer over the table until the table move (+) handle appears. Click the table 

move handle to select the table you want to sort. Under Table Tools, on the Layout tab, in the Data group, click 

Sort. In the Sort dialog box click the Sort by button and select the column you want to sort by, then select Sort 

Ascending or Sort Descending button. You must also select if your list has a Header row, or No Header row. 

When you do this, Word immediately sorts the table by the column you have chosen. 

Method 

 To sort a table by a single column: 

1. In the document, select the entire column you want to sort by 

2. Under Paragraph, on the Home tab, in the Data group, click Sort 

3. Decide if you want to Sort Ascending or Sort Descending 

4. In the My list has area, select the Header Row option button if the table contains a header row 

5. Choose OK. 

Use Graphics in Word 2010 

In this chapter, we will discuss how to use graphics in Word 2010. You can add beauty to your Microsoft Word 

documents by inserting a variety of graphics. This chapter will teach you two ways of adding graphics. 

Adding Picture in Document 

The following steps will help you add an existing picture in your word document. It is assumed that you already 

have a picture available on your machine before you add this picture in your Word document. 

Step 1 − Click on your document where you want to add a picture. 

Step 2 − Click the Insert tab and then click the Picture option available in illustrations group, which will 

display the Insert Picture dialog box. 



 

Step 3 − You can select a required picture using the Insert Picture dialog box. When you will click 

the Insert button, selected picture will be inserted in your document. You can play with your inserted picture in 

different ways, like you can apply quick styles to your picture, you can resize it, or you can change its color too. 

To try it, just -lick your inserted image and Word will give you numerous options available under 

the Format tab to format your inserted graphics. 

 

You can try yourself to insert other available graphics like Clipart, Different Shapes, Charts and SmartArt or 

Screenshots. 

Adding WordArt in Document 

WordArt provides a way to add fancy words in your Word document. You can document your text in a variety of 

ways. The following steps will help you add WordArt in your document. 

Step 1 − Click in your document where you want to add WordArt. 

Step 2 − Click the Insert tab and then click the WordArt option available in the Text group; this will display a 

gallery of WordArt. 



 

Step 3 − You can select any of the WordArt style from the displayed gallery by clicking on it. Now you can 

modify the inserted text as per your requirement and you can make it further beautiful by using different options 

available. To try it, just double-click your inserted WordArt and Word will give you numerous options available 

from the Format tab to format your image. Most frequently used options are Shape Styles and WordArt Styles. 

 

You can try yourself to apply different options on the inserted WordArt by changing its shape styles, colors, 

WordArt Styles, etc. 

Microsoft PowerPoint 

 Microsoft PowerPoint is a presentation program,[7] created by Robert Gaskins and Dennis Austin at a 

software company named Forethought, Inc. It was released on April 20, 1987, initially for Macintosh computers 

only. Microsoft acquired PowerPoint for $14 million three months after it appeared. This was Microsoft's first 

significant acquisition, and Microsoft set up a new business unit for PowerPoint in Silicon Valley where 

Forethought had been located. Microsoft PowerPoint is one of many programs run by the company Microsoft and 

can be identified by its trademark orange, and P initial on the logo. It offers users many ways to display 

information from simple presentations to complex multimedia presentations. 

 PowerPoint became a component of the Microsoft Office suite, first offered in 1989 for Macintosh and in 

1990 for Windows, which bundled several Microsoft apps. Beginning with PowerPoint 4.0 (1994), PowerPoint 

was integrated into Microsoft Office development, and adopted shared common components and a converged 

user interface.  
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Creating a New Presentation 

When you start PowerPoint, the program creates a new, blank presentation just for you. You can make this bare-

bones presentation the starting point for constructing your presentation, or you can get a more sophisticated, fully 

realized layout and design by starting with a template. 

A template is a starter file for creating a presentation. Each presentation is founded on a template. Each 

presentation inherits its colors, designs, fonts, and slide layouts from the template on which it was founded (the 

blank presentation gets its design from a simple, bare-bones template). When you decide between creating a 

presentation from the blank presentation or a template, you are really deciding what your presentation will look 

like. 

Deciding between the blank Presentation and a template 

Templates are a mixed blessing. They are designed by artists and they look very good. Some templates come with 

boilerplate text - already written material that you can recycle into your presentation. However, presentations 

made from templates are harder to modify. Sometimes the design gets in the way. A loud or intricate background 

may overwhelm the diagram or chart you want to put on a slide. For example, the clip-art image on the blank 

presentation slide place on the template slide because the image and the template background are incompatible. 

Starting from the blank presentation means doing the design work on your own, designing presentations is not as 

hard as most people think because you can choose ready-made themes and background styles for a blank 

presentation. Sometimes simpler is better. By starting from a blank presentation, you are not locked into someone 

else's design choices, and you have more creative opportunities. 

The difference between a template and the blank presentation is similar to the difference between a tract house 

and a house you build on your own. 

Buying the tract house is less work. You can move right in. But if you build a custom house, you can build it to 

your taste and specifications, and it is unique. No one has a house quite like yours. Your house looks different 

from the neighbors houses. 

Creating a blank presentation 

PowerPoint shows you a blank presentation each time you open the program. You can save this presentation and 

start to work or, if you are working on another presentation already and you want to create a new, blank 

presentation, you can follow these steps to create it: 

1. Click the Office button and then choose New on the drop-down list. You see the New Presentation dialog 

box appears. 

2. Double-click Blank Presentation. A new presentation appears. You can also create a new blank 

presentation by pressing Ctrl+N. Try visiting the Design tab and choosing a theme or background style to 

get a taste of all the things you can do to redesign a presentation. 

Creating a Presentation from a Template 

The New Presentation dialog box offers many opportunities for finding a suitable template. To open this dialog 

box, click the Office button and choose New on the drop-down list. 

As you employ the following techniques to find a template, remember that you can click the Back or Forward 

button in the dialog box to retreat and advance during your search. Here are all the ways to search for a template 

in the New Presentation dialog box: 

Use a template on your Computer: 



 

Click Installed Templates (you will find this button in the upper-left corner of the dialog box. Templates that you 

loaded on your computer when you installed PowerPoint appear in the dialog box. Double-click a template to 

create a presentation. 

Search online at Microsoft: 

Make sure your computer is connected to the Internet, enter a search term in the Search box, and click the Start 

Searching button. For example, enter "marketing" to search for templates suitable for presentations about 

marketing products. Templates appear in the dialog box. Click a template to examine it. Double-click a template 

to download and use it to create a presentation. 

Use a template you created (or downloaded earlier from Microsoft): 

Double-click the My Templates button. The New Presentation dialog box appears. Select a template and click ok. 

The middle of the New Presentation dialog box lists templates and presentations you recently worked on. Double-

click a template name in the middle of the dialog box if you want to use a template listed there to create your 

newest masterpiece. 

Starting from another presentation 

If you can use another presentation as the starting point for creating a new presentation, more power to you. With 

the New from Existing command, you can nab slides from another presentation and make them the foundation for 

a new one. Follow these steps to commandeer another presentation: 

1. Click the Office button and choose New on the drop-down list. You see the New Presentation dialog box 

and then click the New from Existing button. The New from Existing Presentation dialog box appears. 

2. Locate and select the presentation whose slides and design you covet. 

3. Click the Create New button. We hope you shoplifted that presentation from yourself, not from a 

convenience store. 

Opening and Closing Presentations 

 To get to work on a presentation, you have to open it first. And, of course, you close a presentation when 

you are finished working on it and want to carry on normal activities. These pages explain all the intricate details 

of opening and closing presentations. In these pages, you will find many tips for finding and opening the 

presentation you want to work on. 

Opening a Presentation 

PowerPoint and Windows offer many shortcuts for opening presentations. To open a presentation, take the 

standard route - click the Office button and choose Open - or take advantage of the numerous ways to open 

presentations quickly. 

The slow, conventional way to open a presentation 

If you cannot open a file by any other means, you have to resort to the Open dialog box: 

1. Click the Office button and choose Open on the drop-down list (or press Ctrl+O). You see the Open dialog 

box. 

2. Locate and select the presentation you want to open and then click the Open button. Your presentation 

appears in PowerPoint. You can also double-click a presentation name to open a presentation. 



 

 

The Open dialog box offers a bunch of different ways to locate a presentation you want to open: 

My Recent Documents Button: View presentations you recently worked on in the dialog box. 

 

Look In drop-down List: 

Look for folders or presentations on a different drive, network location, or disk (you can also click the My 

Computer button). Earlier in this tutorial, "Telling PowerPoint where you like to save presentations" explains how 

to make a folder of your choice appear first in the Look In drop-down list. 

 

Back button: 

Revisit folders you saw before in the course of your search. 

 

Up One Level button: 

Move up the folder hierarchy to show the contents of the folder one level above the one you are looking at. 

 

Views drop-down List: 

Display folder contents differently. In the Thumbnails view and Preview view, you can see the first slide in a 

presentation. Details view can be helpful when you have trouble finding a file. In Details view, you see how large 

files are and when they were last edited. 

 

Folders: 

Double-click a folder to see its contents in the Open dialog box. 

If you know the first letter in the name of a presentation you want to open, type the letter in the File Name text 

box. Presentations whose names start with the letter you typed appear on the File Name drop-down list. Select a 

presentation and click the Open button. 

Speed techniques for opening presentations 

The fastest way to open a presentation is to click the Office button and click the presentation's name on the 

Recent Documents list. This list shows the names of the last nine presentations you opened. By moving the 

pointer over a name, you can see which folder it is stored in. Click the pin next to a name to make the name 



remain on the list even if it is not one of the last nine presentations you opened (click a second time to "unpin" a 

name). 

To make more (or fewer) than nine presentation names appear on the Recent Documents list, click the Office 

button and choose PowerPoint Options. In the PowerPoint Options dialog box, click the Advanced category. Then 

enter a number in the Show This Number of Recent Documents box. 

Deleting and renaming presentations in the Open dialog box 

Deleting and renaming presentations are really the business of the Windows operating system, but you can delete 

and rename documents one at a time inside the Open dialog box. Within the Open dialog box, select the 

presentation that needs deleting or renaming and follow these instructions to delete or rename it: 

Deleting a presentation: 

Click the Delete button in the dialog box (or click the Tools button and choose Delete on the pop-up menu, or 

right-click and choose Delete). Then click Yes in the Confirm File Delete message box. 

 

Renaming a presentation: 

Click the Tools button and choose Rename on the pop-up menu (or right-click and choose Rename). Then type a 

new name. 

Here are other speed techniques for opening presentations: 

In Windows Explorer or My Computer: 

Locate the presentation in one of these file-management programs and double-click its name. You can click the 

Start button and choose My Documents to open Windows Explorer to the My Documents folder. 

 

Shortcut icon: 

Create a shortcut icon to a presentation and place the icon on the Windows desktop. In Windows Explorer or the 

Open dialog box, right-click the presentation's name and choose Send To> Desktop (Create Shortcut). To quickly 

open the presentation, double-click its shortcut icon on the desktop. 

Closing a presentation 

Closing a presentation is certainly easier than opening one. To close a presentation, save your file and use one of 

these techniques: 

1. Click the Office button and choose Close on the drop-down list. The PowerPoint program remains open 

although the presentation is closed. 

2. Click the Close button, the X in the upper-right corner of the PowerPoint window (or press Alt+F4). 

Clicking the Close button closes PowerPoint as well as your presentation. 

MODULE IV: MS EXCEL AND SOFTWARE PACKAGES  

Microsoft Excel 

Microsoft Excel is a spreadsheet developed by Microsoft for Windows, macOS, Android and iOS. It 

features calculation, graphing tools, pivot tables, and a macro programming language called Visual Basic for 

Applications. It has been a very widely applied spreadsheet for these platforms, especially since version 5 in 

1993, and it has replaced Lotus 1-2-3 as the industry standard for spreadsheets. Excel forms part of the Microsoft 

Office suite of software. 

Basic operation 
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Microsoft Excel has the basic features of all spreadsheets,[7] using a grid of cells arranged in numbered rows and 

letter-named columns to organize data manipulations like arithmetic operations. It has a battery of supplied 

functions to answer statistical, engineering, and financial needs. In addition, it can display data as line graphs, 

histograms and charts, and with a very limited three-dimensional graphical display. It allows sectioning of data to 

view its dependencies on various factors for different perspectives (using pivot tables and the scenario manager). 

It has a programming aspect, Visual Basic for Applications, allowing the user to employ a wide variety of 

numerical methods, for example, for solving differential equations of mathematical physics, and then reporting 

the results back to the spreadsheet. It also has a variety of interactive features allowing user interfaces that can 

completely hide the spreadsheet from the user, so the spreadsheet presents itself as a so-called application, 

or decision support system (DSS), via a custom-designed user interface, for example, a stock analyzer, or in 

general, as a design tool that asks the user questions and provides answers and reports. In a more elaborate 

realization, an Excel application can automatically poll external databases and measuring instruments using an 

update schedule, analyze the results, make a Word report or PowerPoint slide show, and e-mail these 

presentations on a regular basis to a list of participants. Excel was not designed to be used as a database. 

Work with Date in MS Excel 

 If you use Excel regularly, I'm sure you've come across dates and times in your cells. Data often has a 

record of when it was created or updated, so knowing how to work with this data is essential. 

Here are three key skills that you'll learn in this tutorial: 

• How to format dates in Excel so that they appear in your preferred style 

• Formulas to calculate the number of days, months, and years between two dates 

• An Excel date formula to log today's date, and a keyboard shortcut to add the current time 

Microsoft Excel can basically do anything with data, if you just know how. This tutorial is another key step to 

adding skills to your Excel toolbelt. Let's get started. 

Typing Dates and Times in Excel 

For this part of the tutorial, use the tab titled "Typing Dates & Times" in the example workbook. 

One of the keys to working with dates and times in Excel is capturing the data correctly. Here's how to type dates 

and times in your Excel spreadsheets:  

1. How to Type Dates 

I recommend typing dates in the same format that your system uses. For our American readers, a full date would 

be in the "day/month/year" format. European style dates are "month/day/year." 

 
When I'm typing dates, I always type in the full date with the month, day and year. If I only want to show the 

month and the year, I'll simply format it that way (more on that in a minute.) 
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2. How to Type Times 

It's easy to type times in Excel. We can specify anything from just an hour of the day, to the exact second that 

something took place. 

If I wanted to log the time as 4PM, I'd type "4 pm" into a cell in Excel and then press enter: 

 
Notice once we press enter, Excel converts what we've typed into a hours : minutes: seconds data format.  

Here's how to log a more specific time in your spreadsheet: 

 
The key is to use colons to separate the section of the time data, and then add a space plus "AM" or "PM." 

3. How to Type Date-Time Together 

You can also type combinations of dates and times in Excel for highly specific timestamps. 

To type a date-time combination, simply use what we've already learned about typing dates, and typing times.  

 
Notice that Excel has converted the time to a 24 hour format when it's used in conjunction with a date, by default. 

If you want to change the style of this date, keep reading. 

Bonus: Excel Keyboard Shortcut for Current Time 

One of my favorite Excel keyboard shortcuts inserts the current time into a spreadsheet. I use this formula often, 

when I'm noting the time I made a change to my data. Try it out: 

Control + Shift + ; 



Formatting Dates in Excel 

For this part of the tutorial, use the tab titled "Formatting Dates & Times" in the example workbook. 

What can you do when your dates are European style dates? That is, they're in a day-month-year format, and you 

need to convert them to the more familiar month-day-year format? 

 
All of these cells contain exactly the same data, they're just formatted in different ways. 

In the screenshot above, what might surprise you is that all six of those cells contain exactly the same data - 

"1/22/2017." What differs is how they're formatted in Excel. The original data is identical, but it can be formatted 

to show in a variety of ways. 

In most cases, it's better to use formatting to modify the style of our dates. We don't need to modify the data 

itself - just change how it's presented. 

Format Excel Cells 

To change the appearance of our date and time data, make sure that you're working on the Home tab of Excel. On 

the Ribbon (menu at the top of Excel), find the section labeled Number.  

There's a small arrow in the lower right corner of the section. Click it to open the Format Cells menu. 

 
To format cells in Excel with built in styles, make sure you're working on the Home tab and click the 

dropdown arrow next to the word "Number" in this screenshot. 

The Format Cells menu has a variety of options for styling your dates and times. You could turn "1/22/2017" 

into "Sunday, January 22nd" with just formatting. Then, you could grab the format painter and change all of your 

cell styles. 
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The Format Cells menu allows you to change the styles of your dates and times without the work of 

changing the original date. 

Spend some time exploring this menu and trying out the different styles for your Excel dates and times. 

Get Data From Dates and Times 

Let's say that we have a list of data that has very specific dates and times, and we want to get simpler versions of 

those formulas. Maybe we have a list of exact transaction dates, but we want to work with them at a higher level, 

grouping them by year or month. 

You can get the year from a date with this Excel formula: 

=YEAR(CELL) 

 
To get just the month from a date cell, use the following Excel formula: 

=MON(CELL) 



 

Find the Difference Between Dates and Times 

For this part of the tutorial, use the tab titled "DATEDIF" in the example workbook. 

While formats are used to change how dates and times are presented, formulas in Excel are used to modify, 

calculate, or work with dates and times programatically. 

The DATEDIF formula is powerful for calculating differences between days. Give the formula two dates and and 

it will return the number of days, months, and years between two dates. Let's look at how to use it. 

1. Days Between Dates 

This Excel date formula will calculate the number of days between two dates: 

=DATEDIF(A1,B1,"d") 

The formula takes two cells, separated by commas, and then uses a "d" to calculate the difference in days.  

 
The DATEDIF formula takes two date cells and calculates the days between them. 

Here are some ideas for how you could use this Excel date formula to your advantage: 

• Calculate the difference between today and your birthday to start a birthday countdown 

• Use a DATEDIF to calculate the difference between two dates and divide your stock portfolio's growth by 

the number of days to calculate the growth (or loss!) per day 

2. Months Between Dates 

DATEDIF also calculates the number of months between two dates. This date formula in Excel is very similar, 

but substitutes an "m" for "d" to calculate the difference in months: 

=DATEDIF(A1,B1,"m") 

However, there's a quirk in the way Excel applies DATEDIF: it calculates whole months between dates. See the 

screenshot below. 
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To me, there are three months between January 1st and March 31st (all of January, all of February, and almost all 

of March.) However, because Excel uses whole months, it only considers January and February as completed, 

whole months, so the result is "2."  

Here's my preferred way to calculate the number of months between two dates. We'll find the date difference in 

days, and then divide it by the average number of days in a month - 30.42 .  

=(DATEDIF(A1,B1,"d")/30.42) 

Let's apply our modified DATEDIF to two dates: 

 
Much better. The output of 2.99 is very close to 3 full months, and this will be much more useful in future 

formulas. 

The official Excel documentation has a complex method to calculate months between dates, but this is a simple 

and easy way to get it pretty close. Writing a good Excel formula is about finding the sweet spot of precision and 

simplicity, and this formula does both. 

3. Years Between Dates 

Finally, let's calculate the number of years between two dates. The official way to calculate years between dates is 

with the following formula: 

=DATEDIF(A1,B1,"y") 

Notice that this is the same as our past DATEDIF formulas, but we've simply substituted the last part of the 

formula with "y" to calculate the number of years between two dates. Let's see it in action: 

 
Notice that this works like the DATEDIF for months: it counts only full years that have passed. I'd rather include 

partial years passing as well. Here's a better DATEDIF for years: 

=(DATEDIF(A1,B2,"d")/365) 

https://support.microsoft.com/en-us/kb/214134#bookmark-2


Basically, we're just getting the date difference in days, and then dividing it by 365 to calculate it as a year. Here's 

the results: 

 
DATEDIF is extremely powerful, but watch out for how it works: it's going to only calculate full months or years 

that have passed by default. Use my modified versions for more precision in the results. 

Bonus: Work Days Between Dates 

The Excel date formulas covered above focus on the number of business days between dates. However, it's 

sometimes helpful to just calculate the number of workdays (basically weekdays) between two dates. 

In this case, we'll use =NETWORKDAYS to calculate the number of workdays between two dates. 

=NETWORKDAYS(A1,B1) 

In the screenshot below, I show an example of using NETWORKDAYS. You can see the calendar showing how 

the formula calculated a result of "4."  

 
If you have known holidays in the timeframe that you want to exclude, check out the official NETWORKDAYS 

documentation. 

Managing Excel workbooks 7& worksheets 

Excel is a Microsoft Office software program that provides worksheets and workbooks. Worksheets are 

documents comprised of rows, columns, and cells. In each cell the user can enter a number, date, text, math 

formula, or Excel function. Worksheets can also display selected data in one of a variety of chart types. 

A workbook is just a collection of worksheets. When the Excel program is first opened, the user is presented with 

a workbook that contains three empty worksheets, also called spreadsheets. The first empty worksheet is 

displayed, and in the bottom left corner of Excel are three tabs - one for each worksheet - with the 

names Sheet1, Sheet2, and Sheet3 as shown in the screenshot below. Arrows also display that allow the user to 

scroll right and left to locate worksheet tabs when a workbook has a large number of worksheets. 
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If you're only using one worksheet, you don't have to delete the two unused worksheets - most folks don't bother. 

Excel workbooks are saved with a file extension of xlsx in newer versions of Excel. Older versions used 

the xls extension. 

How many Excel worksheets can we have in one workbook? Microsoft says the number is limited to your 

computer's memory! It's handy to group together worksheets that are VERY closely related, and especially if you 

are linking data from one worksheet to another. But hopping back and forth using the worksheet tabs can become 

confusing. 

How to View a Worksheet 

To view a worksheet, click on its tab. If the workbook window is not wide enough to display all of the tabs 

because of long worksheet names and/or many worksheet tabs, use the arrows to the left of the tabs to navigate 

left or right, or right-click on any of the arrows and select the desired worksheet from the list that displays. 

How to Rename a Worksheet 

To rename a spreadsheet, right-click on the spreadsheet tab, select Rename from the context menu, and type a 

new name. Or, double-click on the worksheet tab and type a new name. 

How to Insert a Worksheet 

The fastest way to insert a worksheet in a workbook is to simply click on the small tab to the right of the last 

worksheet tab as shown in the image below. Then you can move the worksheet to a different position if desired. 

 

Alternatively, you can insert a new worksheet to the left of an existing worksheet by right-clicking on the tab of 

the worksheet that is immediately to the right of where you want the new worksheet to be located and select Insert 

from the Insert window. Excel always inserts a spreadsheet to the left of the selected worksheet. 

How to Delete a Worksheet 

To delete a worksheet, right-click on the worksheet tab and select Delete from the context menu. 

Excel formulas and functions 

Formulas and functions are the bread and butter of Excel. They drive almost everything interesting and useful you 

will ever do in a spreadsheet. This article introduces the basic concepts you need to know to be proficient with 

formulas in Excel.  

What is a formula? 

A formula in Excel is an expression that returns a specific result. For example: 

=1+2 // returns 3 

 

https://www.keynotesupport.com/excel-basics/excel-linking-worksheets.shtml


All formulas return a result 

All formulas in Excel return a result, even when the result is an error. Below a formula is used to calculate percent 

change. The formula returns a correct result in D2 and D3, but returns a #DIV/0! error in D4, because B4 is 

empty: 

 

There are different ways of handling errors. In this case, you could provide the missing value in B4, or "catch" the 

error with the IFERROR function and display a more friendly message (or nothing at all). 

Copy and paste formulas 

The beauty of cell references is that they automatically update when a formula is copied to a new location. This 

means you don't need to enter the same basic formula again and again. In the screen below, the formula in E1 has 

been copied to the clipboard with Control + C: 

 

FORMATTING AND DATA ANALYSIS 

This section addresses formatting commands that can be used to enhance the visual appearance of a 

worksheet. It also provides an introduction to mathematical calculations. The skills introduced in this section will 

give you powerful tools for analyzing the data that we have been working with in this workbook and will 

highlight how Excel is used to make key decisions in virtually any career. Additionally, Excel Spreadsheet 

Guidelines for format and appearance will be introduced as a format for the course and spreadsheets submitted. 

FORMATTING DATA AND CELLS 

Enhancing the visual appearance of a worksheet is a critical step in creating a valuable tool for you or your 

coworkers when making key decisions. There are accepted professional formatting standards when spreadsheets 

contain only currency data. For this course, we will use the following Excel Guidelines for Formatting. The first 

figure displays how to use Accounting number format when ALL figures are currency. Only the first row of data 

and the totals should be formatted with the Accounting format.  The other data should be formatted with Comma 

style.  There also needs to be a Top Border above the numbers in the total row.  If any of the numbers have cents, 

you need to format all of the data with two decimal places. 

https://exceljet.net/excel-functions/excel-iferror-function


 

Often, your Excel spreadsheet will contain values that are both currency and non-currency in nature. When that is 

the case, you’ll want to use the guidelines in the following figure: 

  

 

The following steps demonstrate several fundamental formatting skills that will be applied to the workbook that 

we are developing for this chapter. Several of these formatting skills are identical to ones that you may have 

already used in other Microsoft applications such as Microsoft® Word® or Microsoft® PowerPoint®. 

1.  

1. Highlight the range A2:D2 in the Sheet1 worksheet by placing the mouse pointer over cell A2 and left 

clicking and dragging to cell D2. Click the Bold button in the Font group of commands in the Home tab of 

the ribbon. 

2. Click the Border button in the Font group of commands in the Home tab of the Ribbon (see Figure 1.32). 

Select the Bottom Border option from the list to achieve the goal of a border on the bottom of row 2 below 

the column headings. 
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Creating charts in MS Excel 

1. Select the data for which you want to create a chart. 

2. Click INSERT > Recommended Charts. 

3. On the Recommended Charts tab, scroll through the list of charts that Excel recommends for your data, 

and click any chart to see how your data will look. 

4. If you don’t see a chart you like, click All Charts to see all the available chart types. 

5. When you find the chart you like, click it > OK. 

6. Use the Chart Elements, Chart Styles, and Chart Filters buttons, next to the upper-right corner of the 

chart to add chart elements like axis titles or data labels, customize the look of your chart, or change the 

data that is shown in the chart. 

7. To access additional design and formatting features, click anywhere in the chart to add the CHART 

TOOLS to the ribbon, and then click the options you want on the DESIGN and FORMAT tabs. 

Uses of SPSS for univariate & multivariate analyses 

What is SPSS? 

SPSS is short for Statistical Package for the Social Sciences, and it’s used by various kinds of researchers for 

complex statistical data analysis. 

The SPSS software package was created for the management and statistical analysis of social science data. It was 

was originally launched in 1968 by SPSS Inc., and was later acquired by IBM in 2009.  

Officially dubbed IBM SPSS Statistics, most users still refer to it as SPSS. As the world standard for social 

science data analysis, SPSS is widely coveted due it’s straightforward and English-like command language and 

impressively thorough user manual.  

SPSS is used by market researchers, health researchers, survey companies, government entities, education 

researchers, marketing organizations, data miners, and many more for the processing and analyzing of survey 

data.  

While SurveyGizmo has powerful built-in reporting features, when it comes to in-depth statistical analysis 

researchers consider SPSS the best-in-class solution.  

Most top research agencies use SPSS to analyze survey data and mine text data so that they can get the most out 

of their research projects. 

The Core Functions of SPSS 

SPSS offers four programs that assist researchers with their complex data analysis needs. 

Statistics Program 

SPSS’s Statistics program provides a plethora of basic statistical functions, some of which include 

frequencies, cross tabulation, and bivariate statistics. 

Modeler Program 

SPSS’s Modeler program enables researchers to build and validate predictive models using advanced statistical 

procedures. 

Text Analytics for Surveys Program 

https://www.surveygizmo.com/resources/blog/cross-tabulation/


SPSS’s Text Analytics for Surveys program helps survey administrators uncover powerful insights from 

responses to open ended survey questions. 

Visualization Designer 

SPSS’s Visualization Designer program allows researchers to use their data to create a wide variety of visuals like 

density charts and radial boxplots with ease. 

In addition to the four programs mentioned above, SPSS also provides solutions for data management, which 

allow researchers to perform case selection, create derived data, and perform file reshaping.  

SPSS also offers the feature solution of data documentation, which allows researchers to store a metadata 

dictionary. This metadata dictionary acts as a centralized repository of information pertaining to data such as 

meaning, relationships to other data, origin, usage, and format. 

There are a handful of statistical methods that can be leveraged in SPSS, including:  

• Descriptive statistics, including methodologies such as frequencies, cross tabulation, and descriptive ratio 

statistics.  

• Bivariate statistics, including methodologies such as analysis of variance (ANOVA), means, correlation, and 

nonparametric tests.  

• Numeral outcome prediction such as linear regression.  

• Prediction for identifying groups, including methodologies such as cluster analysis and factor analysis.  

The Benefits of Using SPSS for Survey Data Analysis 

Thanks to its emphasis on analyzing statistical data, SPSS is an extremely powerful tool for manipulating and 

deciphering survey data.  

Fun fact: The data from any survey collected via SurveyGizmo can be exported to SPSS for detailed analysis. 

Exporting survey data to SPSS’s proprietary .SAV format makes the process of pulling, manipulating, and 

analyzing data clean and easy. 

By doing so, SPSS will automatically set up and import designated variable names, variable types, titles, and 

value labels, meaning that minimal legwork is required from researchers. 

Once survey data is exported to SPSS, the opportunities for statistical analysis are practically endless.  

In short, remember to use SPSS when you need a flexible, customizable way to get super granular on even the 

most complex data sets. This gives you, the researcher, more time to do what you do best and identify trends, 

develop predictive models, and draw informed conclusions.   

Univariate analysis 

In this section, you will learn how to create a new variable, run a frequency statistic, calculate the mean of a 

continuous variable, and build a histogram. 

Before we begin, please download the Crime Survey for England Wales 2011-2012 (or CSEW) from the UK Data 

Service website. This way, you'll be able to follow along with our analyses. 

 

https://www.surveygizmo.com/resources/blog/the-challenge-of-analyzing-open-ended-survey-questions/
https://www.surveygizmo.com/resources/blog/cross-tabulation/
https://www.surveygizmo.com/resources/blog/cluster-analysis/
https://www.surveygizmo.com/resources/blog/factor-analysis/


What factors influence police confidence? 

Univariate analysis refers to the quantitative data exploration we do at the beginning of any analysis. These 

analyses provide us with descriptions of single variables we are interested in using in more advanced tests and help 

us narrow down exactly what types of bivariate and multivariate analyses we should carry out. 

We’ll start our univariate analysis with operationalizing our research question. We can do this by 

determining which variable most suits our concept of confidence in the police. There is no one variable in the 

CSEW dataset that concerns police confidence. There are, however, six variables, called polatt1 through polatt7, 

which address the CSEW respondents’ opinions of how successful the police are at curtailing crime and how much 

trust the respondents have in their local police force. 

Each of these variables contains answers to questions about confidence in the police, and because we are 

curious about all aspects of police confidence, we are interested in the responses to all of these questions. We could 

analyse each of them separately, but overall confidence is a good place to start. Because we want to analyse the 

responses to all of the polatt variables, we can use SPSS to combine these six questions about police confidence 

together, creating one new variable for us to use. 

(Important note: we are only creating a new variable because we don’t have one better suited for us in our 

dataset. Transforming variables is done when you need the data to work better for you. This is not necessarily a 

technique that needs to be employed every time you select a dependent or independent variable. However, knowing 

how to transform variables is really useful when you find yourself with a research question that requires some 

tailoring. This website hopes to show you how to troubleshoot certain issues that may arise when you’re working 

with real, full datasets. One of these potential issues is the lack of a functional, pertinent dependent variable, and this 

section will show you how to overcome this problem through variable transformation.) 

Polatt1-polatt7 are categorical variables, with responses falling into distinct categories on a 1 through 5 

scale. When we combine all of the polatt variables into one single variable, we’ll have created a continuous 

variable. This is because SPSS will collapse each respondent’s six polatt responses into one total police confidence 

score, giving us a range of numerical scores from 6 to 30. For example, a respondent who answered "1" or "Strongly 

agree" in response to all six of the polatt questions would score a 6 on our new confidence in the police scale, as 

1+1+1+1+1+1 = 6. SPSS will do this calculation for each respondent's answers to the polatt questions, and provide 

us with a continuous range of values we can use in our analyses. 

There are a few necessary conditions to keep in mind if you decide to transform categorical variables into a 

continuous variable: 

• The categorical variables must have data collected from the whole sample. In some datasets, like the CSEW, 

some variables represent the responses to questions only some of the survey participants have answered, 

because some questions are only asked of part of the survey sample. You can check to make sure your 

variables meet this condition by searching for them in the survey questionnaire and ensuring that they have 

been asked of all participants. 

• The categorical variables you select need to contain data concerning the same basic questions. For example, 

you would not want to compress data from a variable about the number of dogs in a neighbourhood with a 

variable about the amount of money made selling cars. Those two variables use two different measures to 

answer two different questions. 

• The categorical variables must use the same units of measure. In our case, the categorical variables we select 

must all use the same point scale, either “1 through 4” or “1=strongly agree to 5=strongly disagree.” In 

addition, these scales need to be going in the same direction, meaning that you wouldn’t collapse two 

variables together if one was measured with “1=strongly agree” and the other was measured with 

“1=strongly disagree.” (If they do not use the same point scale, or use scales going in different directions, we 

can transform the data in the variables so that the measurements match.) 

 

MODULE V: WORLD WIDE WEB  

 

Introduction 

The Internet is an increasingly important part of everyday life for people around the world. But if you've never 

used the Internet before, all of this new information might feel a bit confusing at first. 



Throughout this tutorial, we'll try to answer some basic questions you may have about the Internet and how it's 

used. When you're done, you'll have a good understanding of how the Internet works, how to connect to the 

Internet, and how to browse the Web. 

What is the Internet? 

The Internet is a global network of billions of computers and other electronic devices. With the Internet, it's 

possible to access almost any information, communicate with anyone else in the world, and do much more. 

You can do all of this by connecting a computer to the Internet, which is also called going online. When someone 

says a computer is online, it's just another way of saying it's connected to the Internet. 

What is the Web? 

The World Wide Web—usually called the Web for short—is a collection of different websites you can access 

through the Internet. A website is made up of related text, images, and other resources. Websites can resemble 

other forms of media—like newspaper articles or television programs—or they can be interactive in a way that's 

unique to computers. 

The purpose of a website can be almost anything: a news platform, an advertisement, an online library, a forum 

for sharing images, or an educational site like us! 

Once you are connected to the Internet, you can access and view websites using a type of application called a web 

browser. Just keep in mind that the web browser itself is not the Internet; it only displays websites that are stored 

on the Internet. 

How does the Internet work? 

At this point you may be wondering, how does the Internet work? The exact answer is pretty complicated and 

would take a while to explain. Instead, let's look at some of the most important things you should know. 

It's important to realize that the Internet is a global network of physical cables, which can include copper 

telephone wires, TV cables, and fiber optic cables. Even wireless connections like Wi-Fi and 3G/4G rely on these 

physical cables to access the Internet. 

When you visit a website, your computer sends a request over these wires to a server. A server is where websites 

are stored, and it works a lot like your computer's hard drive. Once the request arrives, the server retrieves the 

website and sends the correct data back to your computer. What's amazing is that this all happens in just a few 

seconds! 

Other things you can do on the Internet 

One of the best features of the Internet is the ability to communicate almost instantly with anyone in the 

world. Email is one of the oldest and most universal ways to communicate and share information on the Internet, 

and billions of people use it. Social media allows people to connect in a variety of ways and build communities 

online. 

There are many other things you can do on the Internet. There are thousands of ways to keep up with news 

or shop for anything online. You can pay your bills, manage your bank accounts, meet new people, watch TV, 

or learn new skills. You can learn or do almost anything online. 

Web search engine 

A web search engine or Internet search engine is a software system that is designed to carry out web 

search (Internet search), which means to search the World Wide Web in a systematic way for particular 
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information specified in a textual web search query. The search results are generally presented in a line of results, 

often referred to as search engine results pages (SERPs). The information may be a mix of links to web pages, 

images, videos, infographics, articles, research papers, and other types of files. Some search engines also mine 

data available in databases or open directories. Unlike web directories, which are maintained only by human 

editors, search engines also maintain real-time information by running an algorithm on a web crawler. Internet 

content that is not capable of being searched by a web search engine is generally described as the deep web. 

Opening E Mail ID: 

How to create email account? 

Follow the steps below to create email account at mail.com for free: 

• Click on the Free Sign Up Button 

• Enter all mandatory fields (First Name, Last Name, Gender, etc.) 

• Type in your desired Email Address out of our huge selection of 200 available domains (e.g. biker.com, 

accountant.com, chef.net, etc.) 

• Choose a secure Password (at least 8 characters, mixing letters, numbers, lower and upper case, and using 

special characters) 

• Select your Security Question, type in your Answer 

• Verify your registration by typing the numbers in the captcha picture 

• Click the "Accept" - Button underneath 

Create email account and enjoy the benefits of mail.com 

Looking for a new email account which offers powerful spam and virus protection? Do you need features to 

organize your time and manage emails and files easily? Your mail.com free email account is waiting for you. 

Benefit from great tools and features to keep your work safe and become more efficient. To create email account 

you will only need a few minutes and it's easier than ever. 

When you are about to create free email account at mail.com there are few things worth considering. 

• First of all, before you create email account think of your username. Will you use your email as private or 

professionally? Make sure your username defines your purpose. 

• Next thing is the domain you are going to use. mail.com lets you choose from over 200 domains! Running 

a business? You can choose: consultant.com, engineer.com and many more for example. What is your 

hobby? Make sure to say it loud for example with: artlover.com or bikerider.com. Surely, mail.com’s wide 

choice of domains will meet your needs. 

• And of course the password. Keep your email account safe and remember that the length of a password 

determines its security strength as the time required to crack longer passwords increases exponentially. 

Therefore, your password should consist of at least 8 characters and contain both capital and lower case 

lettering, as well as numbers and special characters (e.g., "!", "&", "-".). We recommend you change your 

password from time to time in order to increase the security. Do not choose a password that is easy to 

guess, e.g. personal data such as: your initials, your date of birth, or the name of a family member or a pet. 

How to Download Files 

Zipped Collection of HMD Statistics (New) 

To facilitate the use of HMD data in research projects, we now have available a package of the same data that are 

viewable online. The zipped archives are organized by type of statistics and by country. In addition, the entire 

collection (all countries, all statistics) is available for download. See the Zipped Data Download Page. 
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PC Users 

The easiest way to download the text (ASCII) data files is: 

1. Right click on the link to the data file of interest (e.g., 1x1), 

2. Left click on Save Target As (Internet Explorer) or Save Link Target As (Netscape, Mozilla), 

3. Specify the directory (folder) where you want to save the text file (e.g., fltper_1x1.txt), and 

4. Left click on Save. 

Alternatively, if you have already opened a data file in your web browser, then: 

1. Right click from anywhere in the data file, 

2. Left click on View Source (Internet Explorer) or Open File in New Window (Netscape), which will open 

the file in a text editor, 

3. Left click on File on the menu bar, 

4. Left click on Save As 

5. Specify the directory where to save the file, and 

6. Left click on Save. 

You may now open the file in a text editor (e.g., Notepad, Wordpad, Emacs), import the data into Excel (see 

instructions below), or read the data into a statistical package (e.g., SAS, Stata, SPSS, S-plus). 

Opening Text Data Files in Excel 

To open the data file in Excel: 

1. Left click File on the menu bar, 

2. Left click Open , 

3. Specify the type of text file (*.prn, *.txt, *.csv ), 

4. Left click on the data file to select it, and 

5. Left click on Open. 

6. The Text Import Wizard should automatically appear. By default, Excel should select the appropriate 

format, so you may simply left click on Next at each step (i.e., Step 1: fixed width; Step 2: you may 

change the width of columns if you like or use the default; Step 3: you may change the data format for 

each column or use the default) and left click on Finish to import the data. 

Note: These instructions are for Excel 2002; they may differ for earlier versions of Excel (please consult your 

manual or on-line help menu under "import data"). 

Combining several data files into a single long file 

Downloading and decompressing zipped data files from the HMD website return numerous folders and files 

containing various output data (Zipped Collection of HMD Statistics). The folders correspond to the type of 
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output data (e.g. death rates, life tables etc.), to male or female gender, and to six age-by-year data formats (1x1, 

1x5, 1x10, 5x1, 5x5, 5x10). Each folder contains dozens of country-populations. For analyses with statistical 

packages, it would be more practical to operate with a single long data file pooling together many population-

specific data files. For transforming numerous data files into one, two simple programs have been developed for: 

1) pooling together life tables for many countries and years in a single file and 2) death rates for many countries 

and years in a single file (MPIDR Technical Report TR-2016-001). 

Reading Text Data Files into a Statistical Package 

Please consult your statistical package manual or on-line help menu for instructions on importing data in a tab-

delimited ASCII (text) format. You may need to delete the first three header lines using a text editor before 

importing the data (so that the file contains only columns of data). 

Benefits of doing business online 

You don't have to run your entire business over the internet to benefit from online business opportunities. Small 

businesses might only need an email address to communicate with their clients, customers and suppliers 

electronically. Other businesses might use their website to conduct their entire business online. 

The many benefits of online business include: 

• global access, 24 hours a day, 7 days a week 

• improved client service through greater flexibility 

• cost savings 

• faster delivery of products 

• increased professionalism 

• less paper waste 

• opportunities to manage your business from anywhere in the world. 

Customers may prefer to visit your website to find out about your products and services, instead of visiting you in 

person. They will also expect to see your website address and your email on business cards and other promotional 

materials. 

Online business opportunities 

How you manage your business online will depend on the products or services you offer. You may be able to use 

the internet to: 

• run an online shop 

• manage your suppliers 

• communicate with your customers, and get their feedback on your business 

• offer services online 

• allow customers to make reservations or appointments online 

• manage your finances, such as online banking, tax and employee pay 

• research competitors. 

Future opportunities 
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Keep in mind that your business, as well as the variety of online tools available, is constantly changing and 

evolving. While you might not plan to have a website immediately when you start operating, it's still a good idea 

to think about whether you will need one at a later date and what you will use it for. 

When you are planning the online aspects of your business, you should: 

• research your competitors and other businesses that use online tools 

• decide what aspects of online business will benefit your business 

• review your budget to work out what you can afford 

• familiarise yourself with any laws and regulations that will apply to your online business activities 

• consider your requirements, including what software you need and what types of computer equipment you 

need to run it 

• plan for risks, such as computer viruses, scams, data theft and loss of or damage to hardware 

• think about what training you or your staff might need 

• be realistic about the time and budget you will need to manage the online aspects of your business. 

 


